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versaAssets Overview 

 

versaAssets is an add-on Windows application that is available for versaSRS Pro, versaSRS 

Business and versaSRS Enterprise editions. 

The versaAssets Agent is used to scan hardware and software of the assets within the 

computer network that are discoverable. The versaAssets will then return the results of the 

managed assets and populate that information into versaSRS. Unmanaged assets are 

entered into the system manually.  

The data recorded via versaAssets Agent provides a snap shot of the network infrastructure. 

The results of the scan can be used to identify legacy items on the network or outdated 

software. Reports can also be created within versaSRS to retrieve an overview of asset status 

or for detailed CMDB purposes. 

This document outlines the versaAssets Agent module and how to install and configure the 

module for viewing results in versaSRS. Also included is the definition of the screens that you 

can use to manage the assets within versaSRS. 

 

 

  



Download and Installation 

 

The download link to the versaAssets installer is contained within the versaSRS homepage 

under the Overview Menu is a link to the Companion Tools & Modules. 

The versaAssets Agent can be downloaded and installed, however functionality is not 

enabled unless the module is activated in versaSRS via the Pro, Business or Enterprise edition 

license key.  

There are two ways in which to configure versaAssets - either as an Agent or Agentless. 

Information on how to configure for either appears in the section on Config File Settings – 

Scan Mode. 

An Agent mode requires that the application is installed and run in each discoverable asset 

on the network. This requires additional effort to setup and may not be satisfactory for 

remote networks. The Agent will then push the information back to versaSRS. 

An Agentless mode requires the application to be installed on a server as a single instance. 

The Agentless application will then, when started, go out to all discoverable assets and return 

the values into versaSRS. This is in effect a pull strategy where the information is pulled from 

each discoverable asset. The server where versaSRS is installed is suitable for Agentless 

configuration. 

 

Setting up versaAssets Web Service in versaSRS 

 

versaAssets Agent  is dependent upon the versaAssets Web Service, included as a 

part of versaSRS by default. No configuration of this Web Service should be required. If 

configuration of versaAssets Web Service is required then see below:  

 

1. In IIS, where versaSRS is installed, create a new Application Pool, Set Identity to 

“Network Service”.  

2. Create a Web Site pointing to the location where the VersaAssets web service is 

located.  

3. Set Authentication to “Anonymous” 

 

 

http://www.versasrs.com/


Installing versaAssets 

 

Once downloaded and unzipped the installer is available to run. The following dialogue box 

appears when the setup is double clicked. 

 

 

 

 

Fill out the following screen with the administrative account details. 

 

 



 

 

 

 

 

 

 

 

  



The domain account entered must have access to the workstations/servers that are to be 

scanned. 

Complete the below dialogue box with the desired email details. Emails will be sent to 

recipients if alerts are raised by the versaAssets. (Optional) 

 

 

 

 

 

 

 

 

 

 

 

 

Click Next 

 



 

 

 

 

 

 

 

 

 

 

Installation will occur 

 

 

 

 

 

 

 

 

 

 

 

 

You may see a dialogue box flash on the screen as the process finalises. 

 



 

 

 

 

 

 

 

 

 

 

 

The module is now installed. 

 

 

 

 

 

 

 

 

 

 

 

 

  



Running versaAssets  

 

The following screen shot shows versaAssets when it is run. 

 

 

Go to the File > Configure to set the application for your system as shown below 



 

 

This will bring the following configuration page 



 

 

Set the Administrator name and its password, your domain, and desired mode of scan 

(Agent or Agentless). Then press start on the main page as shown below: 



 

   

Important Consideration 

 

All Computers in the domain need to have: 

 

1. Remote Procedure Call (RPC) service running 

  

2. Remote Registry service running  

 

3. On Windows Firewall settings, enable Windows Management Instrumentation pass 

through for both in and out of the computer.  

 

You can run the following commands to achieve the above:  

net start "RpcSS"  

net start "RemoteRegistry"  

netsh advfirewall firewall set rule group="windows management 

instrumentation wmi)" new enable=yes 

 



 

versaAssets Log File Location   

 

Ensure that the path ‘C:\Temp’ exists on the local machine or the server. This is the location 

to where the LogFilePath will be updated and you can see when the asset was last scanned. 

As required you can change the setting in the Config file by changing the following line.  

<add key="LogFilePath" value="C:\Temp" /> 

                                         

How Does versaAssets Integrate With versaSRS? 

 

Once the versaAssets module has been purchased via Service Desk or ITSM editions and the 

new license key has been installed then the Search Asset icon in versaSRS   will now 

function. 

You will now be able to scan for the set amount of discoverable nodes (workstations/servers) 

based on your purchased edition of versaSRS. 

Please Note: 

If you have used the versaAssets service that values will only be returned if the asset has the 

versaAssets service installed. For Agentless the Server will be able to pull the information to 

versaSRS for all discoverable nodes (workstations/servers). 

Asset Search 

 

In versaSRS the asset search  allows you to search for an asset based on a number of 

selectable criteria or by free-form entry. 

 



 

 

By pressing the asset search button the results will be returned. 

The assets may span additional pages and the pages can be scrolled to by using the clickable 

buttons shown as forward and back buttons. 

Stored Information  

 

You can edit Asset Manufacturers, Product, Supplier, Sold To and Product Type via 

Administrator > System Tools > Systems Table: 



 

 

Further changes can be made to Asset-related system labels under Administrator > 

System Tools > System Labels. 

 

 



General Tab 

The general tab allows you to assign the information of the asset. This includes:- 

 

Asset ID The assigned asset id – must be entered 

Type 
If managed will be populated 

If unmanaged it will appear grey as you have selected the asset type 

Serial # The manufacturers Serial # - to be entered 

Model To be entered 

Location To be entered 

Manufacturer Details of the manufacturer of the product. 

Status Is the asset in use, not in use etc 

Quantity # of units 

Asset Tag Asset Tag # assigned to the asset 

Configuration / 

Installation Details 
Enter any details in relation to the install that may be relevant to the asset. 

History Records all changes in any tab 

Details Tab 

The details tab allows you to assign the information of the asset. This includes:- 

 

Details Any associated details 

History Records all changes in any tab 

 

Purchase / Sale Tab 

The purchase /sale tab allows you to assign the information of the asset. This includes:- 

 

Purchase Date Selectable by pressing he calendar icon 

Purchase Price Value of the asset 

Sale Date Selectable by pressing he calendar icon 

Sale Price The price realized for the asset upon sale 

Supplier Selectable list 

Purchase Invoice The purchase invoice number form the supplier 

Sold to Who the asset was sold to 

Current Value The value associated with the asset 

Total Service Cost Any maintenance costs can be recorded here 

Total Depreciation Depreciation of the asset – to be entered 

History Records all changes in any tab 



 

Lease Tab 

The lease tab allows you to assign the information of the asset. This includes:- 

 

Leased From Who is the lease provider 

Schedule Details of the schedule from the lease 

Start Date Select a start date for the lease 

Expiry Date Select an expiry date for the lease 

History Records all changes in any tab 

Warranty Tab 

The warranty tab allows you to assign the information of the asset. This includes:- 

 

Warranty Type Select the period of the warranty 

Under Warranty Tick box to quickly show if the asset is under warranty 

Start Date Select a start date for the warranty 

Expiry Date Select an expiry date for the warranty 

Warranty Details Any specific details in relation to the warranty 

Notify Press to receive a notification for when the asset warranty expires 

History Records all changes in any tab 

Assigned To Tab 

The assigned to tab allows you to assign the information of the asset. This includes:- 

 

Title Salutation of the asset owner if required 

First First Name 

Middle Middle Name 

Last Last Name 

Known As Name known as if different from first name 

Phone Phone contact details 

Fax Fax contact details 

Mobile Mobile phone details 

Company Company associated to 

Position Employees current position 

Division1 Which division does the employee sit in 

Department Which department are they in 

Location Where is the department located 

Ext. Phone extension number if applicable 

Email 
Enter an email address, if needed to email the owner of the asset then 

please press the email button which will open an Outlook email 

History Records all changes in any tab 



Links Tab 

The Links tab allows you to assign linked assets to this asset. Here you can link a group of 

assets together for example: monitors, keyboard, mouse, VOIP phone, etc to the asset. 

Grouping assets can be beneficial for CMDB display via a report. 

 

History Records all changes in any tab 

 

Record History Tab 

The Record History tab of any changes to the asset over the life of the asset. 

 

History Records all changes in any tab 

 

Notes Tab 

The Notes tab allows a free form text box to be used to record additional information 

around the asset. 

 

History Records all changes in any tab 

 

Attachments Tab 

The Attachments tab allows you to upload any copies of the warranty, purchase order, or 

any other document that is associated with the asset. 

 

History Records all changes in any tab 

 

  



Managed Assets 

 

Managed assets are the assets on the Network that have been scanned by versaAssets 

Service.  The scanned assets can then be ‘searched for’ by typing in a description and 

pressing the search button. 

All assets that have been scanned and are now contained within versaSRS are suffixed by 

“(versaAssets Agent)”. 

In the following screen print we have searched For ‘VDA’ and pressed search the function has 

then returned the below. 

 

 

The results display both managed and unmanaged assets. 

If you wish to bring back all records, keep the search for field blank and select “Workstation 

(versaAssetsAgent)” for Asset Type, if you wish to see all Workstations discovered by the 

versaAssets Service. 

  



The Details tab 

The details tab contains extra information in relation to the assets scanned. It shows the 

computer name, physical memory, processors, adapters, device id and display settings.  

 

 

 

 

 

When the Software Inventory button is pressed additional information in relation to the 

assets software is presented. You can scroll through the pages using the navigation buttons. 



 

 

Un-Managed Assets 

 

Un-Managed assets are those assets that cannot be scanned by the versaAssets service (see 

list in the appendices). It may be that you wish to add a new asset to the system that has 

been newly purchased also and the asset scan has yet to be performed.  When there is a 

need to do this then you can add the asset by following the steps below:- 

 

1. Using the Select Below dropdown box select the type of asset you wish to 

register, in the example below we will select a fridge to register as an asset. 

 

 

 



2. Press the  New Asset button now to bring up the below window for 

registering the details about the asset. Fill in all the relevant tabs. 

 

 

 

Asset Scanning Limitations 

The asset scanner cannot currently scan the following asset types, due to not conforming to 

Microsoft standards:- 

 

Linux (any assets using Linux) Can be added as unmanaged 

Unix Can be added as unmanaged 

Printers Can be added as unmanaged 

MFD’s Can be added as unmanaged 

VOIP Phones Can be added as unmanaged 

Routers/Switches Can be added as unmanaged 

UPS Devices Can be added as unmanaged 

Monitors Can be added as unmanaged 

Non-Network enabled assets (eg; vehicles, 

furniture, etc) 
Can be added as unmanaged 

 


